[bookmark: _top]전처리 및 형태소 분석
엑셀을 이용한 노이즈 제거
수집된 글을 엑셀로 옮겨 노이즈를 제거한다. 텍스트필터를 이용하여 광고 글, 뉴스기사를 옮겨온 글 등을 제거한다.

형태소 분석
분석용 파일의 준비 및 분석 단위의 결정
분석할 내용을 txt 파일로 만든다. ANSI 형식으로 저장한다.
txt 파일의 라인 단위는 분석의 기본 단위가 된다. 문장 단위로 할 것인지, 문단 단위로 할 것인지, 글 단위로 할 것인지 결정하여 준비한다.[footnoteRef:1] [1:  아래한글에서 찾기⦁바꾸기를 이용하여 분석 단위를 라인 단위로 변환시킬 수 있다. ^n을 적절히 이용해보자.] 

댓글처럼 짧은 글의 경우에는 한 사람의 댓글을 하나의 단위데이터로 사용해야 한다. 그러나 뉴스나 블로그, 혹은 잡지의 글처럼 글이 길어지는 경우, 기사 하나를 하나의 단위 데이터로 볼 것인지, 문단을 하나의 단위 데이터로 볼 것인가에 따라 결과가 달라질 수 있다. 이것은 분석 목적에 맞게 판단하여 나누어야 한다. 
예를 들어 두 가지의 다른 소재에 대한 분석을 할 경우에, 한 기사에서 두 대상을 모두 다루었다고 한다면, 기사 전체를 하나의 단위데이터로 보면 두 대상과 모든 속성들이 같은 정도로 연결되어 유의미한 결론을 얻어내지 못할 것이다. 이때는 문단이나 문장별로 나누는 것이 좋다.

불용어(stopwords)의 선정
의도하는 결과를 얻기 위해 ‘어떠한 품사를 분석에 넣을 것인가’와 ‘어떠한 형태소들을 제외할 것인가’는 연구자가 필수적으로 관여해야 하는 부분이다. 

stopwords란 분석에서 제외할 특정 형태소 목록을 말한다. 예를 들어 ‘있다’와 같은 형태소는 문장의 여러가지 맥락에서 사용되기 때문에 의미있는 결론을 이끌어내는데 도움이 되지 않는다. 따라서 이러한 불용어를 작성하여 분석에서 제외시켜야 한다. 
또한 데이터를 수집한 검색어는 불용어에 추가시켜주는 것이 좋다. 해당 검색어는 모든 문장과 연결되어 있으므로 결과 그래프가 왜곡될 소지가 있기 때문이다.
몇몇 단어들도 불용어에 추가해야 한다. 예를 들어 ‘생각’과 같은 단어들은 제외하는 것이 좋다. 맥락에 관계없이 등장하여 네트워크를 왜곡시키기 때문이다. 이러한 단어들은 경험적으로 발견하여 지속적으로 불용어 목록에 포함시켜야 한다.
또한 분석 대상에 따라서 각기 다른 불용어 그룹을 적용해야 한다. 분석을 진행하다 보면, 검색어처럼 모든 단위데이터에 등장하는 단어 이외에도 주제에 따라 전체적으로 고르게 나타나 결과를 왜곡시키는 단어들이 있다.

불용어는 stopwords.txt에 형식을 맞추어 입력한다.
명사, 대명사, 수사는 콤마( , ) 뒤에 N을, 동사와 형용사는 V를, 그 외는 Z를 함께 기록한다.[footnoteRef:2] [2:  불용어에 등록하였는데도 제외되지 않고 계속 계산될 경우에는 N,V,Z을 바꾸어 등록해본다. 이는 형태소 분석기가 불완전하기 때문이다.] 


형태소 분석
라인 단위로 텍스트가 저장된 ANSI 인코딩의 txt 파일이 준비되었으면, 이제 형태소 분석을 할 차례다. 복수의 텍스트파일도 분석가능하며, 이 때 결과 파일은 각각 독립적으로 만들어진다. 다시 말해 한꺼번에 복수의 텍스트 파일을 분석하거나, 한 번에 하나씩 여러 번 분석하거나 파일의 결과 값은 같다. 복수의 분석일 경우 파일 이름은 이름 순서대로 정렬하였을 때 순서대로 표기되도록 둔다. 예를 들어 1.txt  2.txt  3.txt 처럼 둔다.
textanalysis.bat 와 textanalysis.jar를 폴더에 넣어넣고 textanalysis.bat를 실행시킨다.[footnoteRef:3][footnoteRef:4] 해당 파일이 위치한 폴더의 전체 경로에서 한글이 포함되면 에러가 발생하기 때문에, 영문으로만 구성된 폴더 경로에 넣어놓기로 하자. [3:  bat 파일을 통해 jar 파일을 실행시키기 위해서는 컴퓨터에 JRE(자바 런타임)8 이나 JDK1.8이 설치되어 있어야 한다.]  [4:  textanalysis.bat 파일에는 jar파일을 실행시키는 간단한 명령어 한 줄이 포함되어 있다.] 

① 작업 폴더를 선택한다. 이 작업 폴더에 분석 대상 텍스트파일과 stopwords.txt를 넣어두면 편리하다.
② 분석 대상 텍스트파일을 읽어들인다. ①에서 지정한 작업폴더가 기본으로 지정된다.
③ 불용어 파일을 확인하여 읽어들인다.
④ 분석을 진행할 단어의 갯수를 입력한다. 갯수가 100개일 경우, 분석 대상 텍스트를 형태소 분석한 후 형태소 빈도 순으로 정렬하여 상위 100개의 단어까지를 대상으로 동시출현, 피어슨유사성 분석 등을 진행하게 된다. 불용어를 제외한 단어들은 임의로 누락시키지 않는 것이 좋지만, 분석 대상 단어의 편집을 원할 경우, 최종 분석 결과의 개수보다 약간 넉넉하게 개수를 잡아두어야 한다.
⑤ Start! 버튼을 누른다. 별도로 실행되어 있는 콘솔창에 분석의 진행상태가 보이고 작업 폴더에 분석 파일들이 생성된 것을 확인할 수 있다.[footnoteRef:5]  [5:  파일이름에는 분석을 진행한 시각이 포함되어 있으므로 같은 텍스트 파일을 분석하더라도 기존 파일을 덮어쓸 우려는 없다.] 

	00. Gexf for Gephi
	게피를 위한 Dynamic Graph 포맷. 게피에서 open 가능
1.2beta 버전은 게피 0.8버전에서 사용하고, 1.3 버전은 게피 0.9 이상에서 사용한다. 단, Dynamic 그래프는 예상치 않은 에러가 자주 발생한다. 

	01. Statistics.txt	
	라인 수, 형태소 수, 걸린 시간 등을 기록

	02. Word Frequency.txt
	모든 형태소들의 빈도를 내림차순으로 정렬

	03. Sentence with Morpheme.txt
	각 문장의 형태소 수와 형태소들로 구성된 문장을 기록

	04. occurrence Marrix.txt
	선정된 형태소의 문장별 출현빈도를 행렬로 기록

	04. occurrence Matrix-normalized.txt
	문장 길이에 구애받지 않도록 표준화 된 출현빈도 행렬

	05. affiliation Matrix.txt
	공동참여연결망 행렬, UCINET 등에서 사용할 수 있다.

	06. Pearson Matrix.txt
	피어슨 유사성 행렬, UCINET 등에서 사용할 수 있다.

	07. Cosine Matrix.txt
	코사인 유사성 행렬, UCINET 등에서 사용할 수 있다.

	08. Cosine-Pearson Pair Matrix
	코사인과 피어슨 값을 비교할 수 있도록 쌍을 기록한 행렬

	09. Nodes List for Gephi.csv
	게피를 위한 단어와 빈도 리스트

	10. Edges List of affiliation for Gephi.csv
	게피를 위한 공동참여연결망 행렬

	11. Edges List of Pearson for Gephi.csv
	게피를 위한 피어슨 유사성 행렬

	12. Edges List of Cosine for Gephi.csv
	게피를 위한 코사인 유사성 행렬


표준화된 출현빈도는, 전체 텍스트 중 길이가 지나치게 긴 단위 텍스트가 결과 값에 크게 영향을 미치는 것을 방지하기 위해 각 단위 텍스트의 출현 빈도를 각 단위 텍스트의 유효 형태소 수로 나누어 준 것이다. 이후 05, 06, 07, 08 번은 표준화 된 출현빈도 행렬을 통해 생성되었다.

사용자 사전의 등록
형태소 분석 시, 한가지 결과로 분석되어야 하는 단어구가 형태소로 분해되는 경우도 있고, 인명, 지명 등 사전에 없는 단어가 분석되지 않는 경우도 있다. 이 때, 필요에 따라 사용자 사전을 추가할 수 있다.
 textanalysis.jar 파일의 압축을 풀지 말고 알집 등으로 연 상태에서 다음의 경로를 찾아가서 파일을 연다. 
org/apache/lucene/analysis/kr/dic/extension.dic
해당 파일을 메모장으로 열고 적절한 형식에 맞게 단어를 추가한 후 파일을 저장하고 닫으면 다시 압축할 것인지 묻는다.(알집 기준) 다시 압축하여 사용한다.

분석
빈도 분석
기본적인 빈도 분석
빈도 분석은 단어의 빈도를 기반으로 분석하는 것이다. 일반적으로 하나의 데이터 셋의 빈도만을 분석하는 것은 한계가 있기 때문에 데이터 셋 간에 비교를 하거나, 시간별로 끊어 구분한 데이터 셋의 경우 시간 축에 따른 변화의 추이를 알아보는데 사용하기도 한다.
절대빈도보다는 표준화된 상대빈도로 분석하는 것이 일반적이다. 상대빈도로 표준화 할 경우, 데이터 셋에 포함된 총 형태소 수를 기준으로 삼을 수도 있고, 데이터 셋의 데이터 수를 기준으로 삼을 수도 있다. 이는 분석 목적에 따라 다른데, 일반적으로는 총 형태소 수를 기준으로 한다.

분석 대상을 기간으로 구분한 후 주요 단어의 빈도 추이를 분석할 수 있다. 급격히 빈도가 증가한 단어와 빈도가 떨어진 단어들을 중심으로 텍스트를 읽어보면 논의의 추이를 파악하기에 좋다.
변화의 추이를 알아볼 경우, 엑셀을 이용하여 그래프 단계까지 자동적으로 생성되는 환경을 만들어 둔 후, 데이터 결정 단계부터 시각화 단계까지 즉각적으로 알아볼 수 있도록 한다.[footnoteRef:6] 원하는 결과를 최단 시간 안에 뽑아내고 이를 시각화하여 확인하는 것은 데이터 탐색이 필요한 연구의 초중반 진행을 매우 빠르게 만들어준다. [6:  vlookup 등을 이용한다.] 



TF-IDF
TF
빈도 분석의 대표적 방식이다.
TF는 Term Frequency를 말하며, 빈도수가 그대로 쓰이는 경우도 있지만, 문서 안에서의 상대적 중요도를 감지하기 위하여 다음의 공식을 많이 사용한다.

는 해당 문서(d, document)에서 단어(t, term)의 빈도를 말하며,
K는 상수로서, 보통 0.5를 많이 사용한다.
max  는 그 문서 안에서 가장 많은 빈도수를 기록한 형태소의 빈도 값이다. 

위의 공식을 사용하면, 해당 문서에서 가장 많이 등장한 형태소의 tf값은 1이 되며, K까지 차차 줄어들게 된다.

IDF
DF는 Document Frequency를 말하며, 해당 단어가 포함된 문서의 빈도를 말한다. DF는 단어가 나타난 문서를 총 문서의 수로 나누어 구하게 되며, IDF는 Inverse DF이므로 그 역수를 취하여 얻는다. IDF의 공식 역시 여러 가지가 있으나 일반적으로 로그를 취하여 다음과 같이 구한다.

N은 전체 말뭉치(D, corpus)에서 문서의 개수다. 여기서 말뭉치란 분석에 사용한 파일 한 개를 의미하며, 문서의 개수란 라인의 수로 간주한다.[footnoteRef:7] [7:  즉, 우리가 분석하는 파일 하나는 하나의 말뭉치이고, 라인으로 구분된 데이터들 각각은 하나의 문서에 해당한다.] 

idf값이 크면 해당 단어가 문서에서 희귀한 것이 되고, idf값이 작으면 해당 단어가 문서에서 흔한 것이 된다. 흔하기 때문에 중요할 수도 있고, 흔하기 때문에 중요하지 않을 수도 있다. 이것은 경우에 따라 다르게 해석가능하다.

TF-IDF

TF-IDF = tf(t,d) x idf(t,D)

일반적으로 tf값이 클 수록 해당 단어는 중요하다. 그리고 IDF값 역시 클수록 단어가 중요하다. 이 두 값을 곱함으로써 문서 전체에서의 중요도를 파악할 수 있다. 
예를 들어 ‘건물’같은 경우 건축 관련 기사에서 상당히 높은 TF를 가지게 되지만, 매우 자주 등장하는 단어이기 때문에 낮은 IDF값을 지니게 되어, 결과적으로 낮은 TF-IDF값을 지니게 된다.
물론 IDF 값이 낮을 때 중요하다고 판단할지 아닐지에 따라 TF-IDF 값 역시 다르게 해석될 수 있다. 경우에 따라 TF-IDF 값을 사용하지 않고 TF 값만 사용하기도 한다.

사례 : N-gram
구글에서는 전 세계 서적 전체를 디지털화 하고, n-gram 방식을 이용하여 빈도에 대한 검색 추이를 보는 것을 목표로 삼고 있다. n-gram이란 n개의 연속된 단어에 대한 인덱스를 만들어 놓은 것이다. 구글 n-gram viewer는 5gram까지 인덱싱 되어 있다. 여기서 표준화를 위한 빈도의 보정 값은 그 해 전체 문서의 단어 수가 된다.
https://books.google.com/ngrams
빅 데이터에서 빈도분석을 통해 어떤 연구가 가능한지 다음의 서적에 나타나 있다. 저자들은 분석을 통해 불규칙 동사와 규칙 동사의 변천, 나찌 시대의 문화 억압 등 문화사 연구의 새로운 지평을 열었다.
에레즈 에이든, 장바디스트 미첼, 『빅데이터 인문학』, 사계절, 2015

네트워크 분석
ucinet 의 설치와 동시출현 행렬의 입력
https://sites.google.com/site/ucinetsoftware/downloads 에서 ucinet 을 다운받는다. 64비트 사용자는 설치 후 별도의 파일(UCI6_64.exe)을 추가적으로 다운받아 실행시키면 된다. 32비트 버젼을 사용해도 문제는 없다. 3개월 동안 무료로 사용할 수 있다.
실행 후 하단의 경로 설정 창에서 작업 경로를 설정한다.
모두 준비되었으면 동시출현 행렬을 읽어들인다. 엑셀 아이콘을 클릭하여 행렬을 B1 셀에 붙여넣기 한다. A열은 문장 번호가 입력되어야 하나 행렬의 곱에서 사라질 부분이므로 특별히 입력하지 않아도 상관 없다.
[image: ]
저장하기를 눌러 기본 ucinet 파일 (##h) 로 저장한다.

공동참여 연결망 (affiliation network)
affiliation network은 공동참여연결망이라고도 불린다. 동시출현(co-occurrence) 행렬의 곱셈에 의하여 얻어진다. 결과로 얻어지는 수치는, 각 문장에서 두 단어의 출현빈도를 서로 곱한 것들의 총 합계에 해당한다. 단어의 동시출현 매트릭스는 방향성이 없기 때문에 공동참여연결망 역시 대각선 대칭 행렬이 된다. 대각선은 자신의 제곱이므로 의미 없는 값이다.
[Data] → [Affiliation (2-mode to 1-mode)] 을 선택한다.
[image: ]
위의 창에서 Input Dataset 항목에서, 앞에서 저장한 ##h 파일을 읽어들인다.
Mode 는 Columns 을 선택한다. 행과 열 중 어떤 부분을 기준으로 곱할 것인가에 따라 row를 선택할 수도 있다.
Opposite mode normalization 은 None로 선택한다. 정규화가 필요한 경우 none 이 아닌 다른 것을 선택한다.
Method 는 기본 값인 행렬 곱셈(벡터 곱cross-product의 합계)을 선택한다. ok를 누르면 output Dataset로 지정한 경로와 파일명으로 저장된다.

유사성 연결망 (similarity network)
유사성은 –1에서 1의 값을 가진다. -1은 서로 음의 상관관계가 있다는 것이고 1은 양의 상관관계가 있다는 것, 그리고 0은 상관관계가 거의 없다는 뜻이다. 양의 상관관계란, 한 단어가 출현할 때 다른 단어가 출현할 확률이 높다는 것, 즉 두 단어의 상관성이 강하다는 것을 말한다. 음의 상관관계란 한 단어가 출현할 때 다른 단어가 출현하지 않을 확률이 높다는 것이다. 역시 출현여부를 예측하기에 좋으므로 상관성이 강하다고 볼 수 있다.[footnoteRef:8] 상관관계가 없는 것은 한 단어가 출현할 때 다른 단어의 출현을 예측하기 어려운 경우다. 즉 두 단어가 매우 불규칙하게 동시출현하거나 그렇지 않거나 할 경우에 해당한다. [8:  예를 들어 여러 곳으로 휴가를 다녀온 사람들이 쓴 글들을 분석했을 때 ‘수영’과 ‘스키’는 일반적으로 강한 음의 상관관계를 보여줄 것이다. 그러나 두바이에 다녀온 사람의 글에는 두 단어의 상관관계가 양으로 나타날 수도 있다. 이러한 특성을 이용하여 보편적 상관관계와 특정 샘플에서의 상관관계를 비교함으로써 데이터마이닝을 하는 것도 가능하다.] 

피어슨 상관계수 공식은 아래와 같다.
  혹은  
두 식은 을 대입하여 변환 가능하다.
유사성 행렬은 [Tools] → [Similarities] 에서 계산한다.
[image: ]
Input dataset 에 처음의 동시출현 매트릭스.##h 파일을 불러들인다.(주의 : 공동참여연결망을 넣는 것이 아님)
Measure of profile similarity 항목은 Correlation 으로 둔다. 이것은 피어슨 유사성 상관계수를 사용하여 유사성을 계산하는 방식이다. 피어슨 상관계수 공식은 아래와 같다.
Compute similarities among 항목은 columns 를 놓는다. affiliation network와 마찬가지 이유다.
Diagonal valid 항목은 No로 놓는다. 대각선은 의미 없는 값이기 때문이다.

중심성 (혹은 중앙성, centrality)
중심성은 네트워크에서 노드가 가지는 영향력을 말한다. 연결정도 중심성, 근접 중심성, 매개 중심성의 3가지가 기본적인 중심성의 척도다. 공동참여 연결망과 유사성 연결망을 모두 재료로 하여 계산 가능하다. 
중심성은 [Network] → [Centrality and Power] 에서 계산할 수 있다. 연결정도 중심성은 [Degree]를 선택, 근접중심성은 [Closeness Measure], 매개중심성은 [Freeman betweenness]→[Node betweenness] 를 선택하면 된다.
연결정도 중심성(degree centrality)은 1차적으로 인접한 연결정도에 대한 척도다. 한 점이 1차적으로 인접한 점들과의 연결값을 모두 합한 것이다. 
근접 중심성(closeness centrality)은 한 점이 다른 모든 점들에 도달하는 최단거리[footnoteRef:9]를 합한 값이다. 사람의 네트워크에서 근접중심성이 높은 사람이 감염되거나 소문을 퍼트릴 경우 전체 네트워크에 가장 빠르게 확산될 것이다. [9:  인접한 두 점사이의 거리란, 네트워크에서 노드와 노드 사이의 연결값을 말한다. 공동참여연결망에서는 두 점의 벡터 곱의 합(sum of cross-product)이 되고, 유사성 연결망에서는 두 점 사이의 유사성 값이 된다. 다른 점들을 매개로 연결된 두 점사이의 최단거리는 가능한 모든 연결에 대한 거리 값의 합을 계산한 후에 최소값을 택하게 된다.] 

매개중심성(betweenness centrality)은 점 X의 매개중심성은 네트워크 상의 모든 두 점 사이의 최단거리가[image: ] 점 X를 통과하는 정도다. 네트워크에서 매개중심성이 높은 점들의 주변 연결을 차단하면 전체 네트워크로의 확산을 효과적으로 막을 수 있다. 
근접중심성이 높은 점은 네트워크를 공격할 때 공격의 시작점으로서 효과적이며, 매개중심성이 높은 점은 진원지를 알 수 없는 소문이나 전염병을 차단하고자 할 때 방어 지점으로서 효과적이다. 혹은 상권을 분석한다고 할 때, 인접행렬로 표현된 교통의 네트워크에서 매개중심성이 높은 곳은 (중간에서 내릴 수 있다는 가정 하에) 잠재적 수요가 높은 곳이 된다.

A) Betweenness centrality
B) Closeness centrality
C) Eigenvector centrality
D) Degree centrality
E) Harmonic centrality 
F) Katz centrality

그림 출처 : 
https://en.wikipedia.org/wiki/Centrality#/media/File:6_centrality_measures.png



dendrogram & clustering
클러스터링에 의한 덴드로그램은, [Tools] → [Cluster Analysis] → [Hierarchical] 에서 그릴 수 있다.
[image: ]
일반적으로 위와 같은 설정을 적용하면 된다. Input dataset 에는 유사성 행렬을 넣는다.
시각화 
netdraw
파일 열기
넷드로우는 Ucinet을 설치하면 기본적으로 함께 설치되는 시각화 툴이다. [open] → [ucinet dataset] → [network] 에서 공동참여 연결망 혹은 유사성 연결망을 연다.
[image: ]
File format
Ucinet : 노드와 링크만 있는 네트워크를 연다.
VNA : 점 크기, 색상, 선 색 등 여러가지 속성이 포함된 네트워크를 연다.
Type of Data
1-Mode Network : 방향성이 없는 네트워크를 연다. 언어 의미망의 경우 이것을 연다.
2-Mode Network : 방향성이 있는 네트워크를 연다.
Node Attribute : 속성 파일을 연다. 이것은 잘 쓰지 않고 VNA를 주로 사용한다.
Network with Attribute : VNA를 선택할 때 활성화된다. 말 그대로 네트워크와 속성을 함께 연다.
네트워크를 알아볼 수 있도록 조정하기
우선 화살표를 없앤다. 화살표 아이콘을 클릭한다.
표시할 값을 조정한다. 화면 오른쪽의 [image: ] 이 부분을 조정한다. 번개 아이콘을 눌러 refresh 한다.
근처의 width 박스를 체크하여 연결정도에 비례하여 굵기를 표현할 수 있다. 그러나 체크를 해제하여도 되돌아오지 않으니 주의하자(버그).
A와 S 아이콘을 눌러 점의 크기와 글씨 크기를 조정한다.
이러한 속성들은 Properties 에서 세부적으로 들어가 적절히 조정할 수 있다.
Attribute 를 입력하여 점의 크기를 조정하기
네트워크상에서 노드의 빈도를 한 눈에 파악하기 위해 속성을 추가해본다.
[Transform] → [Node Attribute Editor] 를 연다. 메뉴를 통해 열을 하나 추가해본다. 빈도를 입력한다. 엑셀에서 복사&붙여넣기가 가능하다.
[Properties] → [Nodes] → [Symbols] → [size] → [Attribute based] 를 선택한다. 방금 입력한 attribute를 선택하고 sizing에서 최대최소값을 지정한다.
여러가지 중심성 분석하기
[Analysis] → [Centrality measure] 에서 여러가지 중심성 계산하여 attribute 에 추가할 수 있다. attribute에서 확인할 수 있다.
속성이 포함된 네트워크를 저장하기
[File] → [Save data as] → [vna] 로 저장한다. 옵션에서 all nodes and ties 로 저장한다.
저장된 vna파일을 메모장에서 연다. 다시 저장한다. 의미없어 보이는 과정이지만, 과정이 없으면 에러가 발생하여 열리지 않는다. 또한 노드와 노드 사이의 링크 값이 소수점 값을 가지는 경우, 역시 열리지 않는다. 따라서 유사성 연결망은 vna로 저장할 수 없다. 
그림 파일로 화면을 저장하기
[File] → [Save diagram as] → [metafile] 로 저장한다. 벡터 방식으로 저장되므로 확대되어도 깨져보이지 않는다.

Gephi (0.8버전을 기준으로 작성되었으나 0.9버전도 크게 다르지 않다)
Gephi는 인터랙티브한 네트워크 시각화 도구다. http://gephi.github.io 에서 Gephi를 다운받는다. 자바 기반의  어플리케이션이기 때문에 자바를 다운받아야 한다. 
유의할 점은 Gephi 0.8 계열의 경우, 자바 1.8이상에서 버그가 있으므로 자바1.7(jdk 1.7 이나 jre7)을 다운받아 두어야 한다는 것이다. 초기 화면에서 더 이상 진행되지 않을 경우 대부분 자바 버젼의 문제다. C:\Program Files (x86)\Gephi-0.8.2\etc 의 경로로 들어가 gephi.conf를 메모장으로 열어 수정하자. 11번째 줄의 #jdkhome=.... 에서 #(주석처리)을 지우고 jdkhome="C:\Program Files\Java\jdk1.7.0_21" 와 같이 바꾼다. 물론 자신의 컴퓨터에 자바가 설치된 경로 및 1.7.0_21 과 같은 세부 버젼 이름을 일치시켜야 한다. Gephi가 실행되면 new project를 선택한다.
Gephi 0.9 버전 이상의 경우에는 자바 8에서도 작동한다. 단, Gephi 0.9 버전은 VW Text Analyzer에서 제공하는 gexf 파일과 충돌한다. Overview 창이 아닌 Data Laboratory 창이 활성화 된 상태에서 gexf 1.3 버전을 열고 데이터가 로딩된 것을 확인한 후, 풀다운메뉴에서 다른 이름의 gexf로 다시 저장하고, 그 파일을 열어야 정상적으로 동작한다.
기본적인 그래프의 생성과 시각화 설정
데이터 불러오기[footnoteRef:10] [10:  다음을 참고할 수 있다. https://github.com/gephi/gephi/wiki/Import-CSV-Data] 

Gephi는 node와 edge를 데이터를 각각 불러온다. 우선 data table 탭에서 고 Import Spreadsheet를 클릭한다. 데이터는 csv로 저장되어 있어야 한다. 
[image: ]     [image: ]
Node의 csv를 준비할 때 Id와 Label 을 첫 행에 미리 추가하여 두고, id에는 일련번호를, Label에는 Node의 이름을 입력해두어야 한다. 노드의 크기를 특정 값에 따라 다르게 두려면 size와 같은 해당 필드를 추가하여 둔다.
Edge의 csv를 준비할 때는 Source, Target, Type, Weight의 필드값들이 반드시 입력되어 있어야 한다. Source와 Target은 Node 테이블의 Id값과 연동되는 것이다. Weight는 연결선의 강도에 해당한다. Type의 경우 Directed는 화살표, 즉 source에서 target으로의 방향성이 포함된 연결선이고 Undirected인 경우 단순 연결선으로 표시된다.

[image: ]
As table에서 Nodes table인지 Edges table인지 구분하여 선택한다. Charset에서는 적절한 인코딩을 선택한다. ANSI일 경우 EUC-KR을 선택한다.
[image: ]
큰 문제가 없을 경우 위와 같이 Id, Label 및 입력한 여러 가지 값들의 변수type이 자동적으로 설정된다. 문자는 String, 정수는 Integer, 실수는 Float로 설정해주어야 한다.
정상적으로 데이터가 로드되었다면 다음과 비슷한 그림이 나타날 것이다. 화면 하단의 드래그바를 조절하여 선의 굵기를 조절할 수 있다.
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Filter로 포함시킬 edge 정하기
연결선이 많아서 일단 걸러내고 싶을 경우 화면 오른쪽 패널의 filter로 가자. Edge → edge weight를 더블클릭하여 필터에 추가한 뒤 적정 값을 입력한 후 하단의 filter 버튼을 누른다.
[image: ]연결선이 없는 Node를 숨기려면, 필터를 다음과 같이 구성한다. Edge Weight를 Degree Range의 하위에 두면, 현재 네트워크 상 Edge의 갯수들이 Degree Range에 새로 계산되어 보인다. 이때 0부터 된 것을 1로 수정하면 0, 즉 아무 연결선도 없는 node들을 숨길 수 있다. 상황이 업데이트 되면 filter버튼을 누르지 말고, layout 패널에서 stop →run으로 다시 눌러서 업데이트 시키자.
layout 설정
어떤 방식으로 그래프를 그릴 것인지 정한다. 좌측의 Layout→Force Atlas 를 선택 후 play 버튼을 눌러보자. Repulsion Strength와 Attraction Strength 수치를 바꾸어가며 화면의 결과를 확인해보자.
[image: ]
조금 더 알아보기 쉬운 그래프가 만들어졌다.
Node Label 표시
화면 하단의 T 버튼을 눌러 Label을 표시할 수 있다. Label이 한글일 경우 영문 폰트에서는 글자가 깨지므로, 폰트의 종류를 한글 폰트로 설정하면 정상적으로 표시된다.
Node 및 글자의 크기 조정
이제 점의 크기를 바꿔보자. 화면 좌측의 Ranking→Nodes 로 가서 네 가지 아이콘 중 적절한 것을 선택한다. 여기서는 다이아몬드 아이콘을 선택하여 Node의 크기를 조절해보자. 
입력된 데이터 필드 값 중 크기에 적용시킬 항목을 찾고 값들을 셋팅 해준다. Range에는 선택한 필드 값의 최대최소값이 나타나있다. Min size와 Max size를 정해준 후 Apply 버튼을 누른다.
클러스터링을 통한 Node의 색깔 조정
화면 우측 패널의 Statistics → Modularity 에서 run을 누른다. 클러스터링은 edge weight를 토대로 하여 계산된다.[footnoteRef:11] Resolution 값을 1보다 크게 설정할 경우 현재보다 더 적은 수의 그룹으로 나뉘게 된다. OK를 누르면 결과 창이 보인다. Data Table 탭으로 가서 새로운 필드(Modularity Class)가 추가되었음을 확인하자. [11:  알고리즘은 다음을 따른다.
Vincent D Blondel, Jean-Loup Guillaume, Renaud Lambiotte, Etienne Lefebvre, Fast unfolding of communities in large networks, in Journal of Statistical Mechanics: Theory and Experiment 2008 (10), P1000] 

이번에는 화면 좌측 패널의 Partition→Nodes로 가서 refresh 버튼을 누르자. 파티션에 적용시킬 수있는 필드들이 나오고, 여기서 방금 추가된 Modularity Class를 선택한 후 Apply를 누른다. 색이 바뀐 그래프를 확인할 수 있다. Group 버튼을 누르면 단순화 된 그룹별 관계가 보인다. 
Gephi 0.9 이상 버전은 그냥 별도로 Partition 탭이 없고, Nodes의 크기 설정에서 Modularity를 적용시키면 된다.

Exporting Graph
이제 네트워크 그림을 저장해보자. Gephi에서 열리는 전용파일의 저장(save에서 가능) 외에 pdf, png, svg 형식의 저장이 가능하다. svg는 Adobe Illustrator에서 다룰 수 있다.
화면 상단에서 preview 버튼을 누르자.
Preset에서 적절한 항목이 있으면 선택하고, 아니면 직접 입력하면 된다. Show Label 등의 항목을 설정하여 그래프를 조정한다. Refresh버튼을 눌러 각 조정마다 결과 값을 확인한 후 최종적으로 Export한다.
[image: ]

네트워크 척도의 계산
Gephi는 기본적인 visualization외에 몇몇 네트워크 척도들의 계산을 제공한다. 우측패널의 statistics을 다시 보자.
Avg. Path Length는 Betweenness, Closeness, Eccentricity 등을 계산해준다. 실행시키면 Data Table에서 해당 필드 값들이 추가된 것을 볼 수 있다. Ranking 탭으로 가서 여러 가지 값에 따라 Nodes의 크기나 색을 바꿔보자.
Dynamic Graph
형태소 분석기에서 여러개의 파일을 선택할 경우 Gephi에서 시간축에 따라 변화하는 Dynamic Graph를 만들어 볼 수 있다.
우선 형태소분석기의 결과로 생성된 gexf 파일을 Gephi에서 연다. 화면 하단의 Enable Timeline버튼을 누른 후 생성되는 사각형을 드래그하여 왼쪽으로 적절히 축소시키자. 
Filter 창을 보면 Dynamic Range가 추가된 것을 볼 수 있다. 사각형을 드래그하면서 parameters의 변화를 살펴보자. Data Table창에서도 똑같이 해본다.
[image: ]다수의 분석대상 그룹에 따른 결과값을 보려면 다음과 같은 위계로 filter를 셋팅하는 것이 좋다. 
Node의 크기를 Ranking에서 지정할 땐 Auto Apply 를 적용하여 range값에 따라 자동적으로 변하도록 둔다. 아쉽게도, Modularity 에 따른 partition 값을 Dynamic하게 볼 수는 없다.
그리고 Dynamic Graph는 에러가 자주 발생하니 사용시에는 이를 감안해야 한다.
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